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Preface

SINAMICS Documentation
The SINAMICS documentation is structured in 2 levels:
» General documentation/catalogs
» Manufacturer/Service Documentation

An overview of publications, which is updated on a monthly basis, and
also provides information about the language versions available, can be
found on the Internet at:

http://www.siemens.com/motioncontrol

Select the menu items "Support” ’ "Technical Documentation” ' "Overview

of Publications”.
The Internet version of DOConCD (DOConWEB) is available at:

http://www.automation.siemens.com/doconweb

Information about training courses and FAQs (Frequently Asked Ques-
tions) can be found on the Internet at:

http://www.siemens.com/motioncontrol under the menu option "Support”

Table 1-1 Usage phases and the available documents/tools
Usage phase Document/tool
Exploratory SINAMICS S Sales Documentation
Planning/configuration SIZER configuration tool
Decision/ordering SINAMICS S Catalogs
Installation/assembly * SINAMICS S120 Equipment Manual for Control Units

and Supplementary System Components

* SINAMICS S120 Equipment Manual Power Modules
Booksize

* SINAMICS S120 Equipment Manual Power Modules
Chassis

* SINAMICS S150 Operating Manual

© Siemens AG 2006 All rights reserved
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Table 1-1

Usage phases and the available documents/tools

Usage phase

Document/tool

Commissioning

STARTER Parameterization and Commissioning Tool
SINAMICS S120 Getting Started

SINAMICS S120 Commissioning Manual

SINAMICS S120 CANopen Commissioning Manual
SINAMICS S List Manual

SINAMICS S150 Operating Manual

Usage/operation

SINAMICS S120 Commissioning Manual
SINAMICS S List Manual
SINAMICS S150 Operating Manual

Maintenance/servicing

SINAMICS S120 Commissioning Manual
SINAMICS S List Manual
SINAMICS S150 Operating Manual

Target grou

p

This Manual is intended for machine manufacturers, commissioning engineers, and
service personnel who use the SINAMICS S drive system.

Benefits

Note

"SINAMICS S120 Getting Started with the STARTER Commissioning Tool”
provides an example illustrating how to commission a SINAMICS S120 drive

ne-up.

Detailed instructions on commissioning the entire SINAMICS S120 drive line—up
are available in the SINAMICS S120 Commissioning Manual.

The individual chapters provide information on the following:

Vi

Drive concept

Prerequisites

Creating the drive project OFFLINE

Using the STARTER control panel (motor rotates)
Creating the drive project ONLINE

© Siemens AG 2006 All rights reserved
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Standard scope

The function of the standard scope is described in this documentation. Supplements
or changes made by the machine manufacturer are documented by the machine
manufacturer.

Other functions not described in this documentation might be able to run in the
drive system. However, this does not represent an obligation to supply such
functions or when servicing.

Further, for the sake of simplicity, this documentation does not contain all detailed
information about all types of the product and cannot cover every conceivable case
of installation, operation, or maintenance.

© Siemens AG 2006 All rights reserved .
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Technical Support

If you have any questions, please get in touch with our Hotline

Europe and Africa time zone
A&D Technical Support
Tel.: +49 (0) 180 / 5050 — 222
Fax: +49 (0) 180 /5050 — 223

Internet; http://www.siemens.com/automation/support—request

E—mail: mailto:adsupport@siemens.com

Asia and Australia time zone
A&D Technical Support

Tel.: +86 1064 719 990
Fax: +86 1064 747 474

Internet; http://www.siemens.com/automation/support—request

E—mail: mailto:adsupport@siemens.com

America time zone
A&D Technical Support
Tel.: +1 423 262 2522
Fax: +1 423 262 2289

Internet; http://www.siemens.com/automation/support—request

E—mail: mailto:adsupport@siemens.com

© Siemens AG 2006 All rights reserved
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Questions about the manual

If you have any questions (suggestions, corrections) regarding this documentation,
please fax or e—mail us at:

Fax: +49 (0) 9131 /98 — 63315

E—mail: mailto:motioncontrol.docu@siemens.com

Fax form: Refer to the reply form at the end of this manual

Internet address for SINAMICS

http://www.siemens.com/sinamics

EC Declaration of Conformity
The EC Declaration of Conformity for the EMC Directive can be found/obtained
e on the Internet:

http://www.ad.siemens.de/csinfo

under the Product/Order No. 15257461

¢ at the relevant branch office of the A&D MC Business Division of Siemens AG

© Siemens AG 2006 Al rights reserved .
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Safety Instructions

This Manual contains information which you should carefully observe to ensure
your own personal safety and the prevention of material damage. Notices which
are relevant to your own personal safety are highlighted by a safety alert symbol;
notices which are relevant only to equipment and property damage have no safety
alert symbol. The warnings appear in decreasing order of risk as given below.

Danger

indicates that death or serious injury will result if proper precautions are not taken.

Warning

indicates that death or serious injury may result if proper precautions are not
taken.

Caution

with a warning triangle indicates that minor personal injury can result if proper
precautions are not taken.

Caution

without a warning triangle this indicates that property damage may occur if proper
precautions are not taken.

Notice

indicates that an unintended result or situation can occur if the corresponding
information is not taken into account.

© Siemens AG 2006 All rights reserved
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Note

This symbol always appears in this documentation where further, explanatory
information is provided.

If several hazards of different degrees occur, the hazard with the highest degree must
always be given priority. If a warning note with a warning triangle warns of personal
injury, the same warning note can also contain a warning of material damage.

Qualified personnel

The associated device/system may only be set up and operated using this docu-
mentation. A device/system must only be commissioned and operated by qualified
personnel. Qualified persons are defined as persons who are authorized to com-
mission, ground, and tag equipment, systems, and circuits in accordance with
established safety standards.

© Siemens AG 2006 Al rights reserved )
SINAMICS S120 Getting Started with the STARTER Commissioning Tool — 03/2006 Edition Xl



Preface

ESDS information

ii Caution
ElectroStatic Discharge Sensitive devices (ESDS) are individual components,

integrated circuits, or modules that can be damaged by electrostatic fields or

discharges.

Instructions for handling ESDS devices:

¢ When handling electronic components, you must ensure that the person
carrying out the work, the work place, and packaging are properly grounded.

¢ Personnel in ESDS areas with conductive flooring may only handle electronic
components if:
— They are grounded with an ESDS wrist band
— They are wearing ESDS shoes or ESDS shoe grounding straps

¢ Electronic boards should only be touched if absolutely necessary. They must

only be handled on the front panel or, in the case of printed circuit boards, at
the edge.

¢ Electronic boards must not come into contact with plastics or items of clothing
containing synthetic fibers.

¢ Boards must only be placed on conductive surfaces (work surfaces with
ESDS surface, conductive ESDS foam, ESDS packing bag, ESDS transport
container).

¢ Electronic modules must be kept at a distance from data display equipment,
monitors, and televisions (minimum distance from screen: >10 cm).
¢ Measurements must only be taken on boards when:
— The measuring device is grounded (with a protective conductor, for
example).

— The measuring head has been temporarily discharged before
measurements are taken on a floating measuring device (e.g. touching a
bare metal controller housing).

. © Siemens AG 2006 All rights reserved
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Safety information

/N

Danger

The device must not be commissioned until you have ensured that the machine
in which the components described here are to be installed complies with the
98/37/EU Directive.

SINAMICS devices and AC motors must only be commissioned by suitably
qualified personnel.

Personnel must take into account the information provided in the technical
customer documentation for the product, and be familiar with and observe the
specified danger and warning notices.

Hazardous voltages are present in electrical equipment and motors during
operation.

Dangerous axial movements can occur in the system during operation.

All work on the electrical system must be carried out when the system has
been disconnected from the power supply.

SINAMICS devices with AC motors must only be connected to the power
supply via an AC-DC residual-current—operated device with selective switching
once verification has been provided that the SINAMICS device is compatible
with the residual-current—operated device in accordance with EN 50178,
Chapter 5.2.11.2.

Warning

The successful and safe operation of these devices and motors depends on
correct transport, proper storage and installation, as well as careful operation
and maintenance.

The specifications in the catalogs and offers also apply to special variants of
the devices and motors.

In addition to the danger and warning information provided in the technical
customer documentation, the applicable national, local, and system—specific
regulations and requirements must be taken into account.

Only protective extra—low voltages (PELVs) that comply with EN60204—1 must
be connected to all connections and terminals between 0 and 48 V.

© Siemens AG 2006 All rights reserved
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/N

Xiv

Caution

The surface temperature of the motors can reach over +80°C.

For this reason, temperature—sensitive parts (lines or electronic components,
for example) must not be placed on or attached to the motor.

When attaching the connecting cables, you must ensure that:
— They are not damaged

— They are not under tension

— They cannot come into contact with any rotating parts.

Caution

As part of routine tests, SINAMICS devices with AC motors undergo a voltage
test in accordance with EN 50178. Before the voltage test is performed on the
electrical equipment of industrial machines to EN 602041, Section 19.4, all
connectors of SINAMICS equipment must be disconnected/unplugged to
prevent the equipment from being damaged.

Motors must be connected in accordance with the circuit diagram provided.
They must not be connected directly to the three—phase supply because this
will damage them.

Note

When operated in dry operating areas, SINAMICS equipment with three—phase
motors conforms to low—voltage Directive 73/23/EEC.

© Siemens AG 2006 All rights reserved
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Drive Concept 1

This "Getting Started” manual uses simple examples to describe how a standard
drive application is configured.

The standard application comprises a minimum configuration of a SINAMICS S120.
Commissioning is carried out using the STARTER commissioning tool.

This chapter provides an introduction to the SINAMICS drive concept.

Note

A detailed description of the drive system is available in the Commissioning
Manual /IH1/ and Equipment Manuals /GH1/ and /GH2/ (see References in the
appendix).

© Siemens AG 2006 All rights reserved
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Drive Concept

1.1 Components

SINAMICS is a modular system that enables you to build your drive.

The key components of the SINAMICS modular system are:

e Control Unit

¢ Active Line Module (infeed)

e Motor Module (power section)
e Sensor Module

¢ Terminal Module

Fig. 1-1 shows the key drive components (the required 24 V DC power supply, line
filters, line reactors, line contactors, and power cables are not shown):

/e

Sensor Module

Control Unit

‘I/ "DRIVE-CLIQ"

Active Line Module

Terminal Module

Motor Module

Fig. 1-1 Standard components of the SINAMICS modular system

Interface (component connection)

The central Control Unit communicates with the intelligent, peripheral drive
components (Motor Modules, Terminal Modules, and Sensor Modules) via a

standard digital interface (DRIVE-CLIQ).

The physical arrangement of the connections between the Control Unit and
peripheral drive components is known as the DRIVE-CLIQ topology.

© Siemens AG 2006 All rights reserved
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Drive Concept

1.2 Control Unit

The Control Unit is responsible for all closed—loop/open—loop and communication
functions with the drive system components.

The following functions are available:
e Closed-loop control of the Active Line Module (infeed)

¢ Closed-loop control for the drive (comprising the motor, Motor Module, speed
sensor/position encoder, and Sensor Module)

e Communication with a higher—level controller

e Communication with the commissioning system (STARTER)
e Evaluation of the inputs/outputs on the Control Unit

e Evaluation of the optional Terminal Modules

e Evaluation of an Option Board plugged into the Control Unit

© Siemens AG 2006 All rights reserved
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Prerequisites 2

This chapter describes the prerequisites for step—by—step configuration and com-
missioning.

The configuration and commissioning steps are described in detail in Chapters 3
and 5.

2.1 Hardware and software components

In our example, a drive unit is to be assembled for a motor.

The following components are required for the drive unit:

e Active Line Module

e Control Unit CU320

¢ Motor Module

e Sensor Module SMC20

e Synchronous motor (e.g. 1FK6) or induction motor (e.g. 1PH7) with sensor
¢ DRIVE-CLIQ cables

You will also need line filters, line reactors for the Active Line Module, motor,
power, and encoder cables, as well as a SITOP modular 24 V DC power supply,
for example.

The following prerequisites must be fulfilled before you start commissioning:
e The CompactFlash Card with firmware must be inserted.
e The components are wired by means of DRIVE—-CLIQ

¢ The PROFIBUS interface Control Unit is connected to a PC/PG via a
PROFIBUS interface

e The STARTER commissioning tool must be installed on your PC/PG.

Note

For instructions on wiring the components, connecting the PROFIBUS interface to
a PC/PG, and installing the STARTER commissioning tool, see the Equipment
Manuals /GH1/ and /GH2/ and the Commissioning Manual /IH1/.

© Siemens AG 2006 All rights reserved
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Prerequisites

2.2 Wiring the components

Fig. 2-1 shows how the components can be arranged and interconnected for the
sample project. The DRIVE-CLIQ wiring is highlighted in bold.

L1
L2
L3
Q1
NN N - o
24V ISITOP!
external ‘
;%63\5\ 10A : Ql
13 : 14
—o
DRIVE CLIiQ
F X21 ! B x21
A I [T [ [ IITH
100X101 X200 34 | X200 X203 34
EP EP
Control —
unit
320
A Active Line Single Motor
Module Module X500
H r1
Hx124 1| x520
: Sensor
H1 po : Module
v | smc2o
S :
T ="
= =
i
EEEL : 1
N--N-3¢ Line contactor @ @ :
= == i
= = |
!
1
i
4// \
i
Line filter :
rememee—e———————— 4
i
Line reactor H
= (i) 1FK6 or 1PH7
PROFIBUS

D PCIPG

E&

Fig. 2-1 Component wiring (example)
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Prerequisites

221 Assembling the drive unit

The components must be assembled in accordance with the specifications in the
Equipment Manuals /GH1/ and /GH2/ and the DRIVE-CLIQ wiring guidelines in the
Commissioning Manual /IH1/.

Note

The installation and wiring procedures are described in the Chapter "Cabinet
configuration and EMC booksize” in the Equipment Manual.

DRIVE-CLiQ

To assemble the drive unit components, wire the DRIVE—CLIQ cables as follows
(see also Fig. 2-1):

1. Start by connecting DRIVE—CLIQ socket X100 on the CU320 to DRIVE-CLIQ
socket X200 on the Active Line Module.

2. Connect X101 on the Control Unit to X200 on the Motor Module.

3. Connect encoder evaluator X500 on the Sensor Module to the associated Motor
Module using DRIVE—CLIQ socket X202.

PROFIBUS address

4. A PROFIBUS switch that you can use to set the PROFIBUS address for the
drive unit is located behind the lower, petrol-green removable cover on the
CU320. Set the PROFIBUS address (e.g. 5 (S1 + S3 = ON)).

Fig. 2-2 shows the significance of the PROFIBUS switch.

20 21 22 23 24 25 26
1 2 4 8 163264

ON
i ] oFF
S7

S1

Example [kt | | | Jon
B B orF
1 + 4 =5
Fig. 2-2 Example: setting the PROFIBUS via the PROFIBUS switch on the Control Unit

Significance

CompactFlash card

5. Insert the CompactFlash card with SINAMICS S120 firmware into the Control
Unit CU320.

24 V power supply
6. Switch on the 24 V power supply.
PC/PG PROFIBUS interface

7. Use a PROFIBUS cable to connect the PC/PG to the CU320 via the
PROFIBUS interface.

© Siemens AG 2006 All rights reserved
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Prerequisites

2.3 STARTER Commissioning Tool

To start the STARTER application, click the STARTER icon or choose the following
menu path in the Windows start menu: Start > SIMATIC > STEP 7 > STARTER.

Note

The screenshots used in this manual are from STARTER version V3.2. Screens in
other versions may differ slightly from those used here.

2.3.1 The STARTER user interface

You can use STARTER (see Fig. 2-3 on the following page) to create the sample
project. The different areas of the user interface are used for different configuration
tasks:

e Project navigator: this area displays the elements and objects that can be
added to your project.

e Working area: You create the project in this area:

— When you are configuring the drive, this area contains the Wizards that help
you configure the drive objects.

— You can configure the parameters for the speed setpoint filter, for example.

— When you call up the expert list, the system displays a list of all the para-
meters that you can view or change.

¢ Detail view: this area contains detailed information on faults and alarms, for
example.

© Siemens AG 2006 All rights reserved
2-24 SINAMICS S120 Getting Started with the STARTER Commissioning Tool — 03/2006 Edition



Prerequisites

[ STARTER - Project_2 - [Drive_1 - Gpeed controller] _|5 x|
1 Project Target system  View  Optio indow _Help &)

== =T R T

1= |[=lsl= =iz Project navigator: displays the elements
JA;I/ and objects for the STARTER project.

P Project_2
) Insert single drive = =
il [\@ SINAMICS_CLI520
> Overview Adaption
> Configuration P gain [0300 "7 Mmsrad ——
> Topology Reference model
gﬁ:;:s‘j“"'t o = Feselfime  [000 . me =~ ——
i Inputfoutput component 0w | P 0000 Nms#rad
E-_] Drives
#) Insert drive Sl @]
= f Drive_1 A R
> e naviatar J Working area:
» Configuration
> Control logic j Y i f i i
by ol Dlsplqys the_ Wizard for configuring
> Setpoint addition the drive ObjECtS.
>
JE * Displays the parameters for the
> T tpoint: H 1
5 o sepants speed setpoint filter, for example.
> Current setpoint Filker
Y Curentcontroller  — :
> Power unit
> Motor . |
> Mator encoder '_I
-3 Functions = m el
A [» R A R .
Foise & v | Detail view: Displays specific information
B (faults, for example). ——
Level | Message
Error Error nccurred while converting the project.
Error Error on: Convert project!
Error Format ermor (et = Oxbel17001d)
B Convert |
Press F1 to open Help display. offline mode | I

Fig. 2-3 The different areas of the STARTER user interface
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Prerequisites

2.3.2 Principle of the STARTER commissioning tool for SINAMICS S120

When you create a drive unit for a SINAMICS S120 system, the following principles
apply:
The tool is used to configure objects (e.g. infeed). The object name is user defined.

In STARTER, a drive unit always comprises a Control Unit and the associated
drives.

With a controlled infeed, the Active Line Module is configured in STARTER. An
uncontrolled infeed is not configured in STARTER.

The appropriate drive consists, for example, of a Motor Module (power section)
and of a motor with encoder.

Fig. 2-4 shows the STARTER project navigator. You can see that a project
(Project_Philosophy) and a drive unit (Drive_Unit_One_Motor) have been con-
figured for a drive.

[ STARTER - Project_2 - [SINAMICS_CU320 - Topalagy] =&l
) Froject Targetsystem Yiew Options ‘Window Help =181 x]

| Dl(e| 2| 1] o] x| =l || =] | mlm]
5 ol T O - e N S e

=8P Froject 2 Topolagy Froect set Sel foiual Vergleich -
) Insert single drive
Topology trez |
= fflp smamrcs_cuzzn
> Overview Contral_Unit (13
} = s
! ! Free
Supply_1 Free
J Input/output componsnt = TR Crive_1.Power_unit (3)
£ Drives i Fres
) Insert drive
) Drive_t [EHIGLE Drive_15MCL0_to_Motor ()
Free
Free
........ Free
B) Comporent depot =]
| & ' |
Filter: [DRIVE CLiQ + Option Slot
Update tapelagy Coee | Hep |
Project f Dive 1 ( SINAMICS Cu20 |
*
Level | Message
0| 12
Bl convent. [ Topology output
Press F1 ta open Help display. Offline mode

Fig. 2-4 Drive unit with one motor
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If you then want to create a drive unit for two motors, the drive unit will still comprise

one Control Unit and one Active
drives.

Line Module (infeed), but this time will include two

Fig. 2-5 shows the STARTER project navigator. A second drive unit unit with the

name Drive_Unit_Two_Motors,

figured in the same project (Proj

[P STARTER - Project_2 - [SINAMICS_5120 - Topology]

[ Project Target system Wiew Options Wwindow Help

which is designed for two drives, has been con-
ect_Philosophy).

=18l x|
=181 x|

| D@ 2| (=2 o] x| =l | =

| =

| = || e [ e L [ | |

|
| 23] ] e =5

E-89 Project_2
) Insert single drive

Froject set Set Actual Wergleich M

Topolagy

Topology free
= fflp smamcs_clzzn pology I |
; g:s;\w\?:tmn w Control_Unit {1}
3 Topeloay =] Supply_2 (2)
Contral_Unit Free
Supply_t Free

_:1 Input/output componsnt =] Drive_2 Power_unit (3)
i Drives Eren
= !I@ S;szzgijzu | Drive_2,5MC10_to_Makar (5)
Free
é Free
L
Supply_2 Free
4 Inputfoutput component
4| Drives
) Insert drive
B[] Drive_2
I Cumuunenideuut ﬂ
Eiter: [DRIVE CLiG + Option it =
Update topology Cose | Hep |
it 8 Drive 1 | 1 SINAMICS_CU320 @ SINAMICS_S120
M [Leve | Message
« 0]
5] convert R Topolooy output |
Press F1 to open Help display. Offline mode /I
Fig. 2-5 Drive unit with two motors
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2.4 Commissioning

Once you have carried out the steps described in Sections 2.1 to 2.3 (DRIVE-CLIQ
wiring, connecting the Control Unit to a PC/PG via PROFIBUS, STARTER on
PC/PG), you can start commissioning using the example provided.

STARTER offers two alternative methods for creating a drive project:
e OFFLINE: you use a Wizard to configure and parameterize the drive unit.

e ONLINE: you use a Wizard to load the existing drive unit configuration and
parameterization to STARTER.

If you have created or loaded a project in STARTER, you can operate the drive via
the STARTER control panel.

Sections 2.4.1 to 2.4.3 contain tables listing the main commissioning steps for this
example. For detailed descriptions, see Chapters 3 to 5.

241 Creating the drive project OFFLINE
To create the drive project OFFLINE, carry out the following steps:

Table 2-1 OFFLINE

Step Version Chapter/
section
1 Start the STARTER commissioning tool and use the 3.1
STARTER project Wizard to create a new project.
2 Set up the PROFIBUS interface. 3.1
Insert the drive unit. 3.1
4 Use the Wizard to configure the drive unit with, for 3.2

example, the infeed, drive properties, drive with
power section, motor, encoder, and so on.

Save the project. 3.2
6 Continue with "Using the STARTER control panel (motor 4
rotates)”.
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2.4.2 Using the STARTER control panel (motor rotates)

You have to carry out the following steps to use the STARTER control panel and
activate the motor:

Table 2-2 Motor rotates
Step Version Chapter/
section
1 Open the project. 4.2
2 Establish a connection to the target system. 4.2
Switch to ONLINE mode.
3 Load the project to the drive unit. When doing so, watch 4.2
the LEDs on the Control Unit. These indicate when the
project has been fully loaded.
4 Save the parameters in the drive unit with RAM to ROM. 4.2
Use the control panel in the STARTER. The motor starts 4.3
to rotate.
2.4.3 Creating the drive project ONLINE
To create the drive project ONLINE, carry out the following steps:
Table 2-3 ONLINE
Step Version Chapter/
section
1 Start the STARTER commissioning tool. 5.2
2 Create a new project. 5.2
3 Set up the PROFIBUS interface. 5.2
4 Carry out an ONLINE search for the stations (drive units) 5.2
that you can access. The drive unit is inserted in the
project.
5 Configure and enter the drive unit topology and 5.3
configuration automatically.
6 Configure the motor and check the topology that has been 5.4
entered.
7 Save the project. 5.4
8 Continue with "Using the STARTER control panel (motor 4
rotates)”.
|
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Creating the Drive Project OFFLINE 3

This chapter shows you how to create the sample project in STARTER by carrying
out the following activities OFFLINE:

e Creating a new project
e Defining an interface
¢ Inserting a drive unit

¢ Configuring the drive unit and its components
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3.1 Creating the project

Start by opening a new project for your example:

1. To start the STARTER commissioning tool, click the STARTER icon or choose
the following menu path in the Windows start menu: Start > Simatic > STEP 7
> STARTER.

When the software is started for the first time, the main screen (see Fig. 3-1)
appears with the following windows:

"STARTER Project Wizard”
"STARTER Getting Started Commissioning Drive”

i“F STARTER - Project_2 & x|

Project  Target system View Options ‘Window Help

J%Bu e Lo [T J_H

Iﬁﬂ

i 5521 [ | 2 =

==
o 1

The project Wizard can be
called using the menu
Project > New with Wizard.

1 4
Teate FG/PC - Set Insert drives Surnmany

project interface
Anange diive units
offine...
Find diive units
online...

Open existing

plmecl [offline).

IV Display Wizard during start

Cancel

If you deactivate this field,
the project Wizard is not
displayed the next time you
start the STARTER.

E? Starter First Steps

e & =

Ausblenden  Zuriick Wonwats  Aktualisisren  Drucken Optionen

Inek | inges | Suchen| Getting Started Commissioning Drive

Note:

@ Cieate/Properies If you no longer want to display this page automatically at the start, select
@ Project Navigator Options > Settings, go to the Workbench tab and disable the option
Project l_ @ Commsioning Drives | Display Getting Started at start.
o18c Vit ==t m = e e im et mine e bine Aeive mide e il e
Press F1 to open Help display. Offline mode [0

Fig. 3-1 Main screen of the STARTER parameterization and commissioning tool

Note

If you deactivate the "Display Wizard during start” field, the project Wizard is not
displayed when you next start STARTER.

The project Wizard can be called using the menu Project > New with Wizard.
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Note

To deactivate the online help for "Getting started”, follow the instructions provided

in Help.

You can call up the online help at any time by choosing "Help —> Getting started”.

STARTER features a detailed online help function.

2. Close the online help and follow the instructions provided by the Project Wizard

STARTER.

3. Choose Arrange drive units offline (see Fig. 3-2).

© Siemens AG 2006 All rights reserved

Project Wizard Starter |
1. 2 3 4,
|ntroduction Create PGAPC - Set Inzert drives Summany
news project interface
Arrange drive unitz
offling...
L
. ht)
1. Create new project
2. Set up interface
= 3. Inzert drive units
Upen exizhing
project [offline)...
v Dizplay ‘Wizard during start
Cancel |
Fig. 3-2 Project Wizard Starter
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The Wizard guides you through the procedure for creating a new project.

4. Enter the project name and, if required, a comment (see Fig. 3-3).

Project Wizard Starter x|
1. 2 3 4
Introduction Create PGAPC - Set Ingert drives Summary
new project interface

Fleaze enter the project data:

Praject name: |Pr0iek_4
Author: ID oku
Camment;
Getting Started d

[

< Back | Cantinue > | Cancel |

Fig. 3-3 Creating a new project

5. Click Continue > to set up a PROFIBUS interface in the PC/PG.

Project Wizard Starter x|
1 2 3 4
Introduction Create FG/PLC - Set Inzert drives Summary
new project interface

Specify the online connection to the drive unit;

@ Set
CPRE11(PROFIBLIS)

interface;

Change and test... |

< Back | D:untinue%l Carncel |
A

Fig. 3-4 Setting up the interface

6. In this example, you need a PROFIBUS interface in the PC/PG.
Choose Change and test....
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Set PG/PC Interface

Access Path |

Access Point of the Application:

IS?EINLINE [STEF7] -» CPEST1(PROFIBLS)
[Standard far STEP 7)

Interface Parameter Assignment Used:
IEF'551 1[FROFIBLUS)

[Parameter azzignment of your
camrmunications processor CPS511 for a
FROFIBUS netwiark)

Properties..

=

CF'5511[.6.ut0] ;I Diagnostics... |
B CPSS11(MPI)

BEICREE11[FFI) Copy.. |
B CPSS11(PROFIBUS - DP Slave] Delste |
B PS5 11(PROFIBUS) =

 Interfaces

Add/Remove:

Select... |

Cancel |

Help

Fig. 3-5

Setting up the PG/PC interface: properties

7. The system has determined the available interfaces on your PC (e.g. CP5511
(PROFIBUS)). Choose an interface from the Interface Parameter Assignment
Used selection field and then click Properties.

| Eigenschaften - CP551 1{PROFIBUS)
| PROFIBUS |

r Stationsbezogen
¥ PG/PC ist einziger Master am Bus

x]

Adresee: ID _I::‘
™| Oberpriife Adiesse
Timeout: 1z =
— Metzbezogen

Ubertragungsaeschwindigkeit:

126 e

Standard
Univerzell [DP/FMS]
Benutzerdefiniert

Busparameter... |

Huchste Teilnehmeradresse:

Prafil:

= Hetzkonfiguration

™| Folgende Wetzkonfiguration beriizksichtigen

I aster: |1 j Slayes: ID ﬁ
oK. Standard | Abbrechen | Hike |
LY
Fig. 3-6 Properties — CP5511 (PROFIBUS)

8. Enter the following properties in the Properties — CP5511 (PROFIBUS) dialog

box (see Fig. 3-6):

— Click the field PG/PC is the only master on the bus.
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— Station address —> 0

— Transmission rate e.g.: 1.5 Mbit/s
— Highest station address e.g.: 126
— Profile —> DP

. Click OK.

Set PG/PC Interface

Access Path |

Access Point of the Application:

IS?EINLINE [STEF7] -» CPEST1(PROFIBLS) j
[Standard far STEP 7)

Interface Parameter Assignment Used:
|CPS511(PROFIBUS) Properties...

CF'5511[.6.ut0] ;I Diagnostics... |
B CPSS11(MPI)
BEICREE11[FFI) Copy.. |

BRI CPE511[PROFIBUS - DP Slave)

Delste |
EEICPER11(PROFIELS) LI

[Parameter azzignment of your
camrmunications processor CPS511 for a
FROFIBUS netwiark)

 Interfaces
Add/Remove: Select... |
Creel | e |

Fig. 3-7 Setting up the PG/PC interface

10.Click Diagnostics.

You can use the diagnostic functions on the PROFIBUS/MPI Network
Diagnostics tab (see Fig. 3-8) to check whether the communication module for

the PROFIBUS line is ready.
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If the module is ready for operation, the module reads and displays the bus
parameters and version data.

In the second part of the tab (bus nodes), you can generate and display a list of
all the bus nodes in the PROFIBUS line.

SIMATIC NET diagnostics - CP551 1{PROFIB/S il

PROFIELIS /MPI Network Diagnostics | Hardw4

i~ Status/Metwork Diagnostics

Test [ !

Station address I

Bus parameters

Test button

El
r~ Bus Mode

01234567 8910111213141516171819
(U ) ol ol ol s ) ol o o
P01 ) ol ol ol s ) o o o o ol
R ) ol ol ol ) ol o o
U1 )l ol ol o ol ) o o ot ol
IR ) ol ol ol ) ol o o o
meErrrrrrrrrrrrrrrrrrr

aArrrrrrr Key
[~ Station passive
Read | [V Station active
¥ Station active ready
ak | Cancel | Help |

Fig. 3-8 SIMATIC NET diagnostics — CP5511 (PROFIBUS) before the test

11.To check the operating status, click on Test.
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When the module is ready for operation, the text "OK” appears in the field to the
right of the pushbutton (see Fig. 3-9).

In this case, the station address is displayed along with the additional current
bus parameters and version data.

SIMATIC NET diagnostics - CP5511(PROFI 1'
PROFIBUS AP Network Diagnostics | Hardware
— Status/Metwork Diagnostic:
Test | IDK =]
=l
Station address: ID
Bus parameters:
B audrate: 1500.00 Kbps «
Highest station address [HSA): 126
inirmum station delay Time [Min Tsdi): 11 1Bit
I aximum station delay Time [Max Tsdr): 150 tBit
Setup time [tset]: 1 tBit
— Empty checkbox

012345678 391011121314151832  Wwith a light
background

O el ol ol ol
20 ol
N ol ol ot o
BCErrrrrrrrrrrrrrrrrrr
N EEEEEEEEEEEE R
10T el
12 O i o rfe—| Read button

[7 Stal

0k EanceIAJnl\, Help |
_[ﬂs ™

Fig. 3-9 SIMATIC NET diagnostics — CP5511 (PROFIBUS) after the test

12.To display the stations, click Read.

When the module is ready for operation, the system generates a list of all the
active stations on the bus.

The symbols for indicating the operating mode of the station have the following
meanings:

— An empty checkbox with a gray background (same background color as the
tab): No partner device found

— Empty checkbox with a light background: Passive station (e.g. DP slave)
— Checkmark on a light background: Active station (e.g. DP master)

— Checkmark on a gray background: Active station ready to be integrated into
the network

Note

This generates considerable load on the bus and may take a few seconds.

13.To complete the process of setting and diagnosing the PC/PG interface, choose
OK, OK and Continue >.
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14.Add the following (see Fig. 3-10):
A new drive unit with the name SINAMICS_CU320

A device: SINAMICS

A type: S120 (6SL3...)

Version V2.4 and
Bus address (e.g. 5)

Note

The bus address must be the same as the PROFIBUS address set for the Control

Unit

(see Fig. 2-2).

Section 3.2 shows you how to configure the drive unit and its components.

Insert the drive unit by making the appropriate selection in the selection fields
and then clicking on the button Insert.

x
1. 2 3 4,
Introduction Create PG/PC - Set Ingert drives Summary
il project interface
Please enter the drive unit data:
— Preview r Cirive unit
..... % Praject Device: ISinamics j
Type: {5120 R
Wergion: |v2. 4 j
Busz addr.: I 5 j
Namme: [SIMAMICS_CU320
Sinamics tutorial | Insert ! |
Wy
< Back | Continue > | Cancel |
Fig. 3-10 Inserting the drive unit

Note

To insert other drives in the project, choose Insert.
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The first time you choose Insert, the system displays a tutorial featuring an
introduction to the SINAMICS S120 drive unit (see Fig. 3-11).

& uidemoab

Il
SIEMENS

SINAMICS S120
Drive Unit

This tutorial gives you a short, self-explanatory
introduction to the SINAMICS $120 Drive Unit.

The first step teaches you about the available
compenents and their installation and wiring
principle.

The second step shows you the interrelation
between SINAMICS S120 components and
the start-up tool STARTER.

Click on 'f) to show the interactive elements.

Click on fé o go to the next page.

<
b

Fig. 3-11  Introduction

15.Work your way through the introduction by choosing >, or exit by choosing X.

Note

To call up this tutorial, choose Sinamics tutorial.

3-40
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Once you have inserted the drive unit, the Preview window shows you how the
completed project will appear in the STARTER project navigator (see Fig. 3-12).

Project Wizard Starter x|
. ) 3 4
Introduction Create PGEAPC - Set Inzert drives Summary
N project interface

Please enter the drive unit data:

~ Preview r Drive unit
E--% Project Drewvice; ISinamics j
ﬂii SIMAMICS_CU320
Type: {5120 |
Wersion: we 4 -
Busz addr.: 1 -
MHame: IDlive_unit_D

Sinamics tutarial | |nzert I
< Back | I:Dntinued Cancel |
1.

Fig. 3-12  Preview: "Project_2"

16.Click Continue >.

Project Wizard Starter |
1. 2 3 4.
Introduction Create PGEAPC - Set Inzert drives Summary
new project interface
The following zettings have been selected: ﬂ

- Project name: Project
Storage location: C:hSiemenshStepdhS7proj

- Interface: CPE511(PROFIBLUS]
- Drive units:

SINAMICS_CU320 [SINAMICS_S5120 . Addr. 10)

< _>I_I
< Back | Compleler\l Cancel |

Fig. 3-13  Summary

17.To complete the process of creating a new project for a drive unit, choose Complete.
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As you can see in Fig. 3-14, the project Wizard has created Project_2, drive
unit SINAMICS_ CU320, and a Control_Unit in the project navigator.

[P STARTER - Project_2 -0l x|

Project Target system View Options ‘Window Help
| B|=

IEEE R EE B R EE HE
| 2%l | 29 | a4 %5 |
—————————1

E-8 Project_2
7 Insert single drive

2 ffl St
[R4]

> Configuratiort
> Topalogy
[ Control_Unit

Project
Press F1 to open Help display. Ofine mode =TT T

Fig. 3-14 STARTER project navigator "Project_2"

Section 3.2 shows you how to configure the components for the drive unit used
in this example.
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3.2 Configuring the drive unit

The following components are required to assemble the drive unit used in this example:
e Active Line Module

¢ Motor Module

e Synchronous motor (e.g. 1FK6) with sensor for servo control variant

¢ Induction motor (e.g. 1PH7) with sensor for vector control variant

To assemble the drive unit components, proceed as follows:

1. In the project navigator, open the SINAMICS_CU320 directory and double—click
the element Configure drive unit (see Fig. 3-14).

As you can see in Fig. 3-15, the STARTER opens a Wizard for configuring the
drive unit components.

Configuration - SINAMICS_CU320 - Option module

Are pou uzing an option module [option board]?
[Cinzert infeed
(lnzert drive
15 urnirnary

¢ Back Continue > Cancel | Help
L\!

Fig. 3-15  Configuration — SINAMICS CU320 option board

2. An option board is not used in this example.

Confirm the default setting No option board by choosing Continue > to carry
out the next configuration step.
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Configuration - SINAMICS_CU320 - Insert infeed

[6A10 pticin rmadule:
[Clnsert diive This wizard helps you ta configura a drive unit with a drive
S urmary and optionally with an infeed.
Are pou using a SINAMICS infeed with
DRIVE-CLIO connection in this drive unit?
& Ves " Ho
< Back Help

Fig. 3-16  Configuration — Introduction to SINAMICS CU320

3. In this example, you are using a controlled SINAMICS infeed with DRIVE—-

CLiQ connection, an Active Line Module. Confirm the default setting Yes by
choosing Continue >.

Note

If you are using an uncontrolled SINAMICS infeed, click No and then Continue >.

Configuration - SINAMICS_CU320 - Infeed configuration

[MOrtion modul=
[Minsert infead

Configure the infeed drive object:

Drive object Name: Ilnfeed

Cinfe=d General |

[Clinieed diive abiect - ag

CIFROFIEUS process de

[Cinset diive Diive object ype:  [actve rfeed ]
W

Author:
Wersion

Comment:

< Back I Continue 3 I Cancel Help
b

Fig. 3-17  Infeed configuration

4. Click Continue >.
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Configuration - SINAMICS_CU320 - Infeed

(¥ Option module Infeed: Infeed

W] Irizert infeed

[WInfeed configuiation Configure the infeed companent:

. . Component name: Infeed|

[lnfeed drive object - ac

[CIFROFIEUS process d= Supply voltage rangs: ISEU - 480 3-phaze WAl j

[Cinsert drive

]S ummary Cooling method: Ilntemal air cooling j
Type: IEverything except Cabinet Elements ﬂ
Selection
Order no. | Fiated power | Fiated curent -
ESL3130-FTE21-Béme 1B KW
ESLITA0-FTEZ36ms 36 KW EO&
ESLIT30-FTEZE B4 BB KW 924
ESL3130-7TE28-0éme B0 KW 1344
ESLITA0-FTEST-28m: 120 KW 2004
ESLIZ30-FTEZZ2148: 132 KW 2104
ESL3III0-FTEZZE4A2 160 KW 2604
ESL3330-7TE33-84f4x 235 Kw 3804
ESLIZ30-FTEZGO4A% 300 Kw 4504
ESL3Z30-TTEZ6- 1481 380 KW EOG &
ESL3330-7TE3S-44fx 500 Kw 2404 —
ESLIZ30-FTE4T-Oékx B30 KW 9854
IﬁLBBBU-TTEM -AdAy 900 kw 1I4E|5 k) _>|LI

¢ Back I Conlinua>! Cancel | Help |
&t

Fig. 3-18  SINAMICS_CU320 configuration for the Active Line Module

5. First choose the appropriate Active Line Module from the Selection field
according to type (Order No.) (see type plate), assign a name (Supply_1),
and click the Line filter available field.

6. Click Continue > to select additional data for the Active Line Module (infeed)
(see Fig. 3-19).

Configuration - SINAMICS_CU320 - Infeed drive object - additional dal

[# Option madule Infeed: Infeed

() nized corfiguation R | jne/DCink identication at frst switch-on

[ rfeed [The determined values are stored safely against power loss).

[CIFROFIEUS process de Caution . .

Cinsert diive I the DC link capacitance _o_f the dmvg aroup is _suhsgquenlly
changed [remove/add additional devices). the identification must

be performed again.

S ummary

Device connection voltage: 400 W

Riated supply frequency: IEU Hz =

Line filter available

A

Parallel connection nfeed [E5L31 30-FTE21 -Gy - 16 Kitf]
Humber of parallel madulzs: 0=

I Wolkage sersing module available

Humber of YSks:

J

< Back I Cantinue » I Cancel Help
X

Fig. 3-19 Infeed: Additional data

7. Adapt the supply voltage and rated line frequency for the device accordingly.
Click Continue >.
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Configuration - SINAMICS_CU320 - PROFIBUS process data exchange

Infeed: Infeed_1

Option module
[ Inzert infeed

[HAlniced . Select the PROFIBUS meszage frame type:
[w]Infeed - additional data

FROFIBUS PZD message frame: |[RiEERE e kel e WIg= Al

[Cinzert dive
15 ummary

Lenagth:

Input data [words):
Output data [words),

Muotes:

1. The PROFIBUS pracess data will be interconnected ta BICO
parameters in accordance with the selected message frame ype.
These BICO parameters cannat be subsequently changed.

< Back Help |

Fig. 3-20 SINAMICS_CU320 configuration — PROFIBUS process data exchange (infeed)

8. For the infeed in this example, you want a free telegram configuration with
BICO interconnection. Confirm the default setting Free telegram configura-
tion with BICO by choosing Continue >.

Configuration - SINAMICS_CU320 - Insert drive

w15 Lpply
vl rfeed - additional data

Do you want to configure a drive [power unit, motar,
encoder]?

[1Inzert option module

15 urnmary
" ‘Yes Mo

The wizard guides pou through the drive configuration.

b If pou weant b configure several drives, select
— the element "|nzert drive'" in the project navigator
l_"' after finizhing the configuration.

< Back I Continue > I Help |

Fig. 3-21  SINAMICS_CU320 configuration — Introduction to the drive

9. You now want to create a drive with a Motor Module (power section), motor,
and encoder for this example. Confirm the default setting Yes by choosing
Continue >.
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Configuration - SINAMICS_CU320 - Drive properties

W] 5 Ly @ Configure the drive:
[v]Infeed - additional o Mame: IDlive_1
[JFawer urit General | Choose Servo or

[Ckdotor
[C1E nooder
[1Contral type £ zetp

Vector.
Operating type:

Wector 'l

lnsert option moduli;l Operating mode: Jector
r
Lﬁgl ”-‘ Author: ID oku
=
Wersion: W2
Comment: ’G etting Started
< Back I Continue » I Help |

Fig. 3-22  Drive properties

10.The drive properties dialog box (see Fig. 3-22) contains general information
about the drive.

11.1n the selection field, choose "Operating type”.
— Servo: when you are configuring a synchronous motor with servo control

— Vector: when you are configuring an induction motor with vector control
12.Assign a name for the first drive, Drive_1, and enter some general comments.
Click Continue >.

13.In the "Control structure” dialog box, select the "control type” (the default setting
is standard and can be left as it is) and click on Continue >.
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Configuration - SINAMICS_CU320 - Power unit

] Cption module =
[wlInzert infeed
[wlrnfeed

[ Irnfeed - additional o
[WFROFIELS process
W] Inzert dive

W] Dirive properties

W] Contral structure

[CIbdotor
[Cbotor halding brake_|
[CJEncoder

[1Drive functions

—moern e e

Drrive: Diive_1,0D5 0

Configure the power unit:

Mare: IPDwer_unit
Connection voltage: IDC 510720 j
Cooling method. IIntamaI air cooling j
Type: IAII ﬂ
™| Unly display double motar modules with free connections
Mator module selection:
Type [order no. Rate.. | Rated... | Exec.. | Codenu. =
ESLIZ0TETS08A: 27 KW §A DCAAC 10002
ESLI20-2TE1S-064x 27 kW 5A/ . DCAC 10012
ESLI20TEZ21 O8dx  48KW 94 DCAAC 10003

DCAAC 10013

10014
innps T
|

ESL3120-2TE 21044 4.8 ki
ESLAT0-1TE 21-BoA0
B5L3T20-2TE21-BAAx
5'il AN TF P 2NAEy

94/
RS
184 ..
N

3.7 K
9.7 K
1R 1

DC/AC
N

& N fiter/choke
| Sirusaidal filter
! Dutput choke

< Back

oo _|

Fig. 3-23

14.Choose the appropriate Motor Module from the Motor Module selection field
according to type (Order No.) (see type plate) and assign a name (Power unit).

Motor Module configuration

15.Click Continue >.

The following dialog box (see Fig. 3-24) is displayed when you configure an induction

motor with vector control.

Configure an induction motor with servo control and then continue with step 18.

3-48
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Drive: Diive_1,DDS 0

nleed - additional ¢
FPROFIBUS proces:
nhgert drive

Drive properties
Control structure

Standard

Power unit application:

Power Lt
[t atar
[CItdatar halding brake
[C]Encoder ﬂ

Configure the diive properties;

ILoad duty cycle with high over\oatj

< Back

Help

Fig. 3-24  Drive settings

16.Choose the "Standard” and the "Power unit application” as shown in Fig. 3-24
(the default setting can be left as it is).

17.Click Continue > to select the motor (see Fig. 3-25).

Synchronous
motor

Configuration - SINAMICS_CU320 - Mator:

W] Option module: Drive: Drive 1,005 0. MDS 01

@linsert irfeed

Infeed Canfiguie the metar

eed - additional

TPHT107-wrDrn/

1 1u11 A7 s,

EEY

Mame: [t
OFIBLIS procesd
Insert diive  Motor with DRIVE-CLID interace
[@Drive properties I Reed out molor agsin
Contel stuctuae & Seleck standard motor from fist
£ Enler molor deta
[Ftdater haoking Erske|  poror twper
ype: PH7 induction molor -~
D ncoder I =
s ons | Hota sl
____ Fiat | ete | Codsrua
50 /it 10A 516,
TPHAIQwDweslns 100,/ 37, 964 36
PRI D 100/ 37, 364 BE
IPHTIO el 15/ 55 13A 527
IPHA G /0 55 13A 527
IPHAO sl 00 Tk 17.. B89
TPHAG e /200, 7k 17.. 889
PRI whwealne/ 150, 7K. 17.. 516
PRI whws/ 150 7K. 17, S1E
w63 17 ®a

Induction motor

Configuration - SINAMICS_CU320 - Motor

Diive: Drive_1.DD5 0. MD5 O

Canfigure the mator:

feed - additional ¢

Name: |Mmm
ROFIBUS process
sert drive € Motor with DRIVE-CLID interface
I= | Fiead aut metar again
& Select standard motor from ist
" Enter motar data
(I Moter heldng brake 1 porer pes [1FKE synohvonous motor =l

Eneoder

Motor selection:

.|
i
0
L. 2
PR3 pmae 450.. 2.
FRB043we/ Tnuns BO0.. 2. 444 23606
4 | \ecsoin s 0. 3 A 2m07 B
FRB0S/waH ke 450.. 3. 494 23608
ADwFTawess 300 4. 31A 23509
(061wt FTemm: 300 5. S3A 2310
(EDB1-wAHTwumns  460.. 4. 534 23611
FREOE3wAFTeme  300.. 6.. 474 29612 =
[AFKRRLv8F Tumme 300 & TR& %1%

N\

18. Select the motor type.

19. Select the motor
according to type
(Order No.).

Help

Fig. 3-25  Motor configuration

18.Select the motor type e.g.:
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— 1FK6 synchronous motor or

— 1PH7 induction motor

19.Choose the appropriate motor from the Motor selection selection field accord-
ing to type (Order No.) (see type plate) and assign a name (Drive_1_ Motor).

20.Click Continue > to select the motor holding brake (see Fig. 3-26).

Synchronous .
motor Induction motor

[W0pton mode [+ Diive: Diive_1.DDS 0 Diive: Drive_1, DDS 0
[Sllnsert infeed
[lnleed Motor brake selection:
Sllniced - addiiond ¢

PROFIEUS praces: | With holding biske
[lnsert diive ]
WD rive pioperties APH T ss - i
[AComtiol stucture
[P ower unic
[]Hoicr

Maotor brake selection:

€ with holding brake

TFRBrts-itws-weB ot
TFEBunn-rn-tnH 1

ntral structure
e unit

[CJEncoder
[IFROFIBUS poses o

¥ hufihout holing brakel
[E TR l TPH Pt D

TFRBrs-its-wediot
TFEBunn- - wlan

Halding biake configuration: Holding brake configuration:

o mator helding brake installed |

[Ma motar holcing brake installed =l

21. Select “Without holding
brake”. <Back Help

Fig. 3-26  Motor configuration

21.Select Without holding brake and click on Continue > to select the encoder
fitted to the motor (see Fig. 3-27).
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Synchronous

Induction motor
motor

Configuration - SINAMICS_CU320 - Encoder Configuration - SINAMICS_CU320 - Encoder

[0 prion madule Drive: Diive_1, DD O

[S0pton module Difve: Diive_1, DDS 0
[l nset infeed [@inset infeed
Which encader do you want to use? [l Infeed Which encoder do pou want to use?
¥ Encoder | I Ergader 2 [ Encoder3 e [ ol e Encoder 2 Encoder 3
i i | 19 Encodee I Encoder I Encodsr
Encoder 1 | [@linseit drive Encoder 1 |
[F10iive properties
Name: [Hotor

[ Control structure Mame: |Mmm
Powier urit

% Select mator encoder from st &Moo % Select motor encoder from list

€ Enter data Encoder data [#1Mator halding braks " Enter data Engoder data

Motor encoder selection;

Type [orderno] | Encoderype | Resclfion | Code.. |
TFKEsms-wnns-wbing Sindcos incr. 2048 5/R 2001
IFKBamwoiErs ErDatabscl.. 2M485R 2051

1FKBwtewnwGnn ErDat absal..  325/R 2052
TFKBuw-wwns-wSux  Fesolver n-speed 1003
TFKBuuw-wwns-wTux  Fesolver 1-speed 1001

< Back Help < Bark Heln

Fig. 3-27  Encoder configuration

22.Select the encoder from the Motor encoder selection selection field according
to type (Order No.) (see the type plate on the motor) and then press OK.

23.Click on Continue > to select the process data exchange in the next step (see
Fig. 3-28).
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SHTETEMEre Induction motor
motor

[F0ton modue & Drive: Drive 1,005 0
[Wlinsert infeed I
[Wlnfesd

[lnieed - additional ¢
[AFROFIEUS proces:
[inset dive

[ Drive properties
[FACortol structure
[APouer writ

[P0pior modil= <] Diive: Drive_1,DDS 0
[@lnset infieed I
[Wlnieed

[ilnieed - additional c
[FAPAOFIBUS proces:
[lnsert diive

[V Dvive properties

M Contral structure:

Select the PROFIBUS message frame type: Select the PROFIBUS message frame type:

PROFIBUS PZD message frame:

PROFIBUS FZ0 message frame: |{g{

Length: ¥ Power unit
[l Mator itotor Length:
[ otor holding brake| | Input data [words) (M otor holding brake | InPUt data (words): |
[l rcoder — (A rcoder —
| Dutput data [words}: |— | Dutput data (words]: |—

Motes: Mates:

1. The PROFIBUS process data wil be interconnected to BICO
parameters in accordance with the selected message fiame tpe.
These BICO parameters cannot be subsequently changed

1. The PROFIBUS process deta wil be interconnected o BICO
parameters in accordance with the selected message frame type.
These BICD parameters cannat be subsequently changecd

< Back Help < Back Help

Fig. 3-28  Process data exchange

24.For the drives in this example, you want a free telegram configuration with
BICO interconnection. Confirm the default setting Free telegram configura-
tion with BICO by choosing Continue >.

The following dialog box (see Fig. 3-29) is displayed when you configure an induction
motor with vector control.

Configure an induction motor with servo control and then continue with step 26.

Configuration - SINAMICS_CU320 - Important parameters

WIrifeed - additional ca | Drive: Drive_1
Dirive properties
Poveer urit

Dirive zetting

Set the values for the most important parameters:

tdatar cument limit: Im B

tinimum speed: 0.000 1P

I avirum speed; 1500.000 B
o Rarp-up time: |1 0.000 3
5 ”u R arnp-dovat tirne: 10.000 &
]—“ R amp-dawn time with 0.000 s

< Back I Continue > 'E! Help |

Fig. 3-29  Important parameters

25.Click Continue > (the default setting for the most important parameters is
standard and can be left as it is).
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Configuration - SINAMICS_CU320 - Summary.

[irser nieed Th folowing data of the diive unit has been entered:
[Fiieed :

Dption madul: -
[ infeed - addiional ¢ o aplion mecie
[AAOFIEUS poces: | |Infeed
[ st dive Hame: Infeed_1

Dperating type: Ling infeed/feedback
Operating mode: Active ling moduls
[ Contcl stuctre Order no.: ESLE130-7TE21 BA%K
] Fowrer it Rated power: 16 ki
[ b otor Rated cument: 27 A
& Motar halding brake Line fiter: Available
Encoder Woltage sensing module: Not available
e Infoed - addionsl data
[WIFROFIBUS proces: Supply system # DC link identification when first switched on: Yes
Device connection voltage: 400
Rated supply frequency: 50 Hz
PROFIBUS process data exchange (infeed).
PROFIBUS PZD message hame: Free telegram configuration with
BICO (333)
Drive properties:
Name: Drive_1
Operating bype:
Operating mode: Servo amplifier
Control structure:
Control type: Speed control (with sensor)
Power urit: =l

9] Dive properties

Copy text to clipboard |

<Back Help

Fig. 3-30 Summary

26.Check the summary and confirm it by choosing Finish.

As you can see in Fig. 3-31, the configuration Wizard has created the objects
(including Drive_1) for drive unit SINAMICS CU320 in the project navigator.

[FFSTARTER - Project

Project Edit Target system Wiew Options ‘Wwindow Help
T e e e A R == TR Eemlele] |2

=8P Project

-7 Insert single drive
2.8
STy Owerview
1% Configuration
% Topology
Control_Unit

x

Infeed_1
423 Input/output component
(£} Drives
) Insert drive

-] Drive_t
* B Drive navigatar
3 Configuration
> Contral logic
¥ Open-oopjclosed-loop control
» Functions
» Messages and monitoring
» Commissioning
- Communication
- Diagnostics

Praject
Press F1 ko open Help display. Offline mode

Fig. 3-31  Project navigator with SINAMICS_CU320

27.Save project Project_2 by choosing Project > Save.

Once you have configured the drive unit with STARTER in OFFLINE mode, con-
tinue with the steps described in Chapter 4 "Starting the Drive Project (Motor
Rotates)”, where you will set the drive interface parameters and start the motor.

|
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Using the STARTER Control Panel (Motor 4
Rotates)

This chapter shows you how to start the motor by means of the operator panel
function in the STARTER. The steps for this include:

e Loading the project to the drive unit

e Using the control panel

4.1 Prerequisites

The following prerequisites for using the STARTER control panel must be fulfilled:
e The components are assembled (as described in Chapter 2).
¢ The device unit has been switched on in accordance with the instructions.

¢ The PROFIBUS Control Unit interface is connected to a PC/PG with
PROFIBUS interface.

e A project has been created using STARTER.
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4.2 Loading the project to the drive unit

To load the project to the drive unit, proceed as follows:

1. If you have not yet opened "Project_2” (created in Chapter 3) or "Project_1"
(created in Chapter 5) in STARTER, open the project by choosing Project >
Open.

2. To use the "control panel” function, you have to switch to ONLINE mode. To
switch to ONLINE mode, click the function key Connect to target system (as
shown in Fig. 4-1).

%7 STARTER - Project_2 = _|&] x|

Froject Target system View Options Window Help

| Dl S e ol || 7/s0% |
IR AR a1 a5 |

£8P Froet. 2
B Insert single drive
E-flla STHAMICS_CU320
L
> Configuration
- » Topology

B Control Ut 2. Click the function key

Supply_L
P Igutiouut componert Connect to target system.
E{_{ Drives
%] Insert drive
= Drive_1
Lo Drive navigatar
Lo Configuration
Lo > Control lngic
> Speed control
» Functions
» Commissioning
» Communication
» Diagnostics

Project
Saves the project, connects the project o the target system and displays the consistency status. Offline mode

Fig. 4-1 Project navigator with SINAMICS_CU320

3. An ONLINE connection is established and an ONLINE/OFFLINE comparison is
carried out. If any discrepancies are identified, they are displayed (see the
following screenshot).
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Online/offline comparison x|

The canfiguration of Diive_unit_ada3 (DVEU3205) anline differs Ham the project stared affine. The
following differences have been detected:

Oiflire Differences

Onine tapology Project topology

CU_003 (TOCKIUNES ) |CU_003 ( TOCHHUNRS 3
_INF_02 { TOALM ) £_INF_02 ( TOALM )
SERVO_(13 ( TOServosL ) |SERWO_03 ( TOServasL )
SERVO_04 { TOServoSL ) |SERVO_04 ( TOServosL )

If these differences are not adiusted, the onling representation may be incomplete.

Adjust via
<==Dowrload Overwiting of the data in the target device

Load to PG ==> Ovenniting of the data in the project

Diive_unit_add3

Fig. 4-2 ONLINE/OFFLINE comparison, load to target system

4. You changed the data OFFLINE and now have to load it to the target system.
Carry out the following:

Click <— Load to target system in the "ONLINE/OFFLINE comparison”
dialog box.

When the system asks "Are you sure?”, click Yes. The system now starts
loading the data.

When the system informs you that the data was successfully loaded to the
target system, click OK.

Click OK for "Load from RAM to ROM".

5. Discrepancies were identified again during the ONLINE/OFFLINE comparison.
Click Load to PG —> (see screenshot below).

Drive_unit_sddr3

Online, offline comparison x|

The corfiguration of Drive_unit_sdd3 (DWCLI3205) anline difers  from the project stored offire. The
follawing diferences have been detected

Offline Differences

Oniine topology Project topology
SERYO_03 ( TOServosL )|SERYO_03 ( TOServosL )
SERWO_04 ( TOServoiL )| SERYO_04 ( TOServosL )

IFthese diferencss are not adjusted, the online repiesentation may be incomplete:

<==Download Divervriting of the data in the target device
Load to PG ==> l: Ovemwiting of the data in the project

Adust via:

Close Hile:

Fig. 4-3 ONLINE/OFFLINE comparison, load to PG

6. Load the new data from the drive unit to the PG. Carry out the following:

When the system asks "Are you sure?”, click Yes. The system now starts
loading the data.
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— When the system informs you that the data was successfully loaded to the
PG, click OK.

7. No further discrepancies are displayed in the ONLINE/OFFLINE comparison
dialog box. Click Close (see screenshot below).

Online/offline comparisol x|

The canfiguration of [DVCU3205) anline differs nat fram the praject stared affine, The fallawing
differences have been detected

Offiing Differences

If these diffrences are not adjusted. the oriine representation may be incomplete.

Adjust via
<==Dorioad Dverwiting of the data in the target device
Lozt P == Ovarvwiting of the data in the project

Drive_urit_addi3
Close Hife:

Fig. 4-4 ONLINE/OFFLINE comparison, close

Note

When loading the project, note the LEDs on the Control Unit. The Control Unit is
ready for operation when the LED RDY is continuously lit (green).

This completes the procedure for configuring the drive unit hardware. The following
section shows you how to use the control panel in STARTER.
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4.3 Using the control panel

Once you have established a connection with the target system and loaded the
project to the target system, a green plug icon appears in front of the drive unit and
other configured components in the project navigator. This indicates that the project
data in STARTER and the target system is consistent (see Fig. 4-5).

The drive unit is ready to run.

To use the STARTER control panel and start the motor, proceed as follows:

[*F STARTER - Project_2 =

Project Targetsystem View Options iindow Help

| DG 55| (| ol w2 || e || £ | ] ]
¥z oo [ 2 e S T |

=3P Project 2
@77 ort single drive
= [ENUTEED]

L% overview

) Configuration
L% opolon
il Tt
A Supply_L
Inputjoutput compons=
E-_{ Drives
T e e
- A Drive_|

» Drive navigator

> Configuration

» Control logic
- Speed cantral
» Functions
(=3 Commissioring

Green plug icon.

-
[ Communication
% Diagnostics

Double-click Control panel in the
project navigator.

Froject
*
Device [ Operating mode 1
SINAMICS_CUI320. Contiol Unit Fieady
SINAMICS_CLI320.Supph_1 122 hex] Sigral EIN/ALIST mit 01 Flarke setzen [0840)
SINAMICS_CU320 Drive_1 Mo details
SINAMICS_CLI320 Inpu_outpul_component_T Mo detals

i Alarms a Target system output g Topology output. % Diagnostics overview

Press F1 ko open Help display. |Online mode |

Fig. 4-5 Control panel
1. Double—click Control panel in the project navigator under Drive_1 > Commis-
sioning (see Fig. 4-5).

The control panel is displayed in STARTER (see Fig. 4-6). You can use the con-
trol panel to control the drive directly from the PC/PG.
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4-60

[ 5TARTER - Project_2 - sl x|

Project  Control panel  Targetsystem Wiew Options Window  Help

JEIEIEH_IIMEIIM\_IH_E&H_IJ!IEI
= =L | @ || || 28| aalutal ]

=P Project_2
) Insert single drive
=l SINAMICS_CLi320
> Owerview
- » Corfiguration

I T | InDutfuutnut companEnt
[=+i_{ Drives

® ) Insert drive

= @] Drive_1

S~ » Drive navigator
- » Configuration
> Control logic
- speed cantral
» Functions
» Commissioning

T G B

>> Communication
% Diagnostics

IH

Click Assume control priority.

e[|

Selpoint (100%) Scaing Selpt
reEp—— ! JJ [0 pm } . ’V — . ’i_u o
'_ Enghles Assumejreturn contral priority o x| zox 100%
.A\arms # Control panel @ Target system output | [ Topology output | % Diagnostics overview |
Press F1 ta open Help display. [Online mode e

Fig. 4-6 Assuming control priority

2. Click Assume control priority to connect the control panel to the drive inter-
face.

Note the message that is then displayed in the Control priority dialog screen.
This message is very important (see also Fig. 4-7).

Danger
Use control priority with care!

The function should be used for commissioning, diagnostics, and maintenance
purposes only.

Make sure that the drive is in the "OFF” status and that no ON/OFF1 command
has been issued either by the control word for sequence control or another signal
source (e.g. BICO interconnection).

Once control priority has been transferred to the PC, the BICO interconnections on
bit 1 to bit 6 of the control word are no longer active.
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Control priority at PC - Drive_l.51NAM1c5§5

You can use the default monitoring time
(e.g. 3000 ms).

Application monitaring: Y Sl
[0 -» no manitaring) Im Mg

Tip:
To speed up the responsze, it iz recommended that pou increase the baud
rate and cloze all unneceszan windows,

Be careful when uzsing the control pricrityl
The function should only be uzed for commizgioning, for diagnostics ar
during maintenance waork.

Please ensure that the diive is in the
"0OFF" mode and no OMAOFFT command F — A LTt e
anather signal zource [e.q. BICO interconng

To continue with commissioning, choose
After transfering the contral prionty o the Bl OK |
aon Bit 1 ta Bit B of the contral word=i& not ¢

ak /;‘; Cahcel Help...

Fig. 4-7 Transfer control priority to PC

You can enter an application monitoring time, which is the time that elapses be-
tween two setpoints before the sign—of—life monitoring function on the drive re-
sponds (fault 1910).

You can use the default monitoring time (e.g. 3000 ms).

3. Since our example concerns commissioning, confirm this dialog box for assum-
ing control priority by choosing OK.

i [sINaMICS_CUzn - Dive_1 N

Setpoint [100%]
Retum. J J T en |,
e l
Click
[33 hex] Signal 'BB/AUS3' auf 1" setzen [p0848, - - - - -
pOB49) Spesiied_ Actual [s«1  Display/hide diagnostics view.

R Motor speed: 0.0 00 pm

OM /0OFF 2

OM /OFF 3 Motor utilization: 0.0 % Motor current. 0.0 A

Pulse enable
Famp-ct generator enable

Statt/stap rampunction gen.
P, () Setpoint enable (O Enables avalans Crgrmries

88 clars g TSR [T Target system output é
Press F1 o open Help dplay. Status “lamps” for the control word bits. [ [

Fig. 4-8 Diagnostics view

4. To display, amongst other things, the status lamps for the control word bits,
click Display/hide diagnostics view.

Table 4-1 lists the most important digital input signals of the control word for
sequence control. You need these to set the motor in motion and issue them via
the control panel for the Control Unit (CU320).
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Table 4-1 Control word sequence control
Signal PROFIdrive Meaning
(control panel) Bit No. in STW
sequence control
ON/OFF1 Bit 0 0 = OFF (OFF1), stop via ramp—function generator,
followed by pulse block
1 = ON, operating condition
ON/OFF2 Bit 1 0 = Coast down (OFF2), pulse block, motor coasts
to standstill
1 = Do not coast down, operating condition
ON/OFF3 Bit 2 0 = Emergency stop (OFF3)
1 = No emergency stop, operating condition
Pulse enable Bit 3 0 = Disable operation, pulse block
1 = Enable operation, enable pulses
Ramp-function Bit 4 0 = Set ramp—function generator to 0
generator 1 = Enable ramp—function generator
enable
Start/stop Bit 5 0 = Freeze ramp—function generator, retain
ramp— current output value
function 1 = Restart ramp—function generator, follows the
generator input value
Enable Bit 6 1 = Enable setpoint
setpoint 0 = Block setpoint and set to 0
i [SIRBMICS _CUZ20-Drve_tT | lilE

Setport (100%] Scaing Seipt
e Bl 5w | —— |- [==8en
0% 100 200% s

[ Encbles Stop w. space bar - avays works!

e

0N/ OFF 1

ON / OFF 2

ON / OFF 3

Pulse enable

Fiamp-fct generator enable
Start/stop rampfunction gen

PO Sepoint enable

[33 hex] Signal =24US3" auf 1" setzen |
uq)

(DEnables availsbl

Motor

Motor uti

Enables.

Click in the field

08 v P e el [ T eroet system output | [ Topeloy output | % Disgnostcs overvien |

Press F1 ta open Help display

[Online mode [

Fig. 4-9

Enables

5. As shown in Fig. 4-9, click the Enables field to set the commands for enabling
the control words in the drive system.

x
|5INAM\CS_EU320 - Diive_1

o [m[e.

Retum...

¥ Enables

Selpaint [1007%]
DJ 0 rpm
Stop w. space bar W works!

[21 hex] Signal ‘EIN/AUST* mit 0/1-Flanke
setzen [p0840]

0N /OFF 1

Fig. 4-10

Spestad
Motor speed [

Infeed control priority

Infeed control priority.

—_— Setpt
- 0 tpm
100%

6. Click Infeed control priority. The infeed (Active Line Module) is powered-up.
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7. Before starting the motor by choosing Drive on (see Fig. 4-11), you have to
make the following settings:

— Enter a speed setpoint (e.g. 50 revolutions per minute).

— Use the slider to set the setpoint in %. Position your cursor on the slider,
hold down the left mouse button, and set the speed to 0%.

ij Danger
During commissioning, note the machine traversing range and take appropriate
external measures (e.g. monitoring the limit switch).

«
[siNAMICS_CU320 - Drive_1 =l I_I_
Setpoit (100%) Setpt
beun I_EJ [ lpm T pm
¥ Enables Stop . space bar - a' ys works! 0%
21 hex] Signal "EIN/AUST mit [1/1-Flanke
) e e, i\ e Smacthed dive outpL fraque ¥
Mator speed a0 ) 00 1pm a0 He
() ON 2 OFF 1

8. Button )
Drive on Speed setpoint: 50

Percentage to 0%

Fig. 4-11  Control panel before "Drive on”

8. Click Drive on. The ON/OFF1 "enable” command is set and displayed on the
control panel (see Fig. 4-12).

9. Increase the speed slowly as
a percentage from 0 to 100%.

ON/OFF1 “enable”
command set.

q e e

B part (007~ Seding Setpt,
T I_J. 0] o } x’V—J— =’V &1 gm

IV Encfles  Slopw. space bar - always 4.»@ i 102%

[00 hex] Enable all Specfied  Actusl Smanthed dive output fraque ™
M [tor speed 51
QN oFF 1

0 50 pm 25 He

10. Button

Drive off

Fig. 4-12  The motor starts to rotate

9. Move the slider for the speed slowly from 0 to 100% (see Fig. 4-12).
The motor starts to rotate!

10.When you click Drive off, the motor stops. You can also trigger a fast stop by
pressing the space bar.
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The following steps show you how to return control priority to terminate the con-

nection to the drive:

— Supply
— Control Unit

i [5INAMIES U320 - Diive_1 = (e

¥ Enables Stop w. space bar Y amsg works!

Setpant (100%) Scaing
Rietum JI_EUIDM x’V‘ —— =’V

G0 rpm
%

[21 hex] Signal ‘EIN/AUS1® mit 0/1-Flanke ClICk

Fig. 4-13  Infeed control priority

11.Click Infeed control priority (see Fig. 4-13).

setzen [p0BAD] SpEee
#)on a1 Hoarweed "7 Infeed control priority.

il [Siancs o0z Gve = (e
Setpo (10072, [ Sedng
fotin B = J—r— .5

™ Enables Stop W

< ba - ahwaps wol

Click
Return....

O on 7 DFF 1

Fig. 4-14  Infeed control priority

12.Click Return... to terminate the connection to the drive unit (see Fig. 4-14).

Return control priority? (IACP:221)

o .

Make sure that no OM command from the CPU [automation)
iz pending.

Before remaving the contral priority, the PC removes all
enables, BUT the setpoints and commands subsequently
come from the parameterized sources again. If a setpaint is
pending, the drive reacts immediately!! This can be
dangerous!!

ts and ds from set

Do pou want to continue?

es hl Mo |

Fig. 4-15 Return control priority

13.Confirm the query Return control priority? with Yes (see Fig. 4-15).
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The system then returns to the project in STARTER (see Fig. 4-16).
Promnmer proeciz LI

Project Control panel Target system View Options Window Help

JQIEIEII_HM%IEII:&H_HI_&IEI_HIE
&= b o8| e | e | @ || 01| 2] ] 1] %

=B Project 2
) Insert single drive
=-#7ffly SINAMICS U320
S Ovarview
» Confiquration

- Insert drive
=86 Drive_t
> Drive navigator
> Configuration

> Control logic
& Spesd control
-3 Functions
= Cumml;;mmng

- Cummum(atmn
-3 Diagnostics

Project
|S\NAM\E5 T0320- Dive_1 ENArN
Selpmm 6%~ Scalng Sam 5

l‘ Enables o o ooy 100%

121 heal Signal EIN/AUS - it 07 Flarke T

S pecified Actual
T Sl P ke | =
.A\avms ‘ i panel | [ Target system output | [ Topoloy output | %5 Diagnastics averview |
Press F1 to open Help display. [Online mode [

Fig. 4-16  Commissioning complete

Congratulations!

You have successfully completed commissioning a drive using the SINAMICS
S120 drive system.
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This chapter shows you how to create the sample project ONLINE by carrying out
the following steps:

e Create a project.

e Enter and configure the component topology and configuration of the drive unit
automatically.

¢ Configure the drive motors and check the topology.

5.1 Prerequisites

The following prerequisites must be fulfilled before you create a drive project ONLINE
with the STARTER commissioning tool:

e The components are assembled (as described in Chapter 2).
¢ The device unit has been switched on in accordance with the instructions.

¢ The PROFIBUS Control Unit interface is connected to a PC/PG with
PROFIBUS interface.

The SINAMICS firmware is able to recognize the actual topology automatically and
store it in the appropriate parameters.
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5.2 Creating the project
To ensure that the drive unit configuration is identified automatically, open a new
project in STARTER:
1. To start the STARTER commissioning tool, click the STARTER icon or choose
the following menu path in the Windows start menu: Start > SIMATIC > STEP
7 > STARTER.
The Project Wizard Starter is displayed.
Project Wizard Starter x|
1. 2 3. 4
Introduction Create PG/PC - Set Inzert drives Summary
niew project interface
Arrange diive units
offline...
Find drive units
otline...
1. Create new project
2 Set up interface
3 Search for drive unitz and
ingert in the project
hd LA E=payy v Qi Wy saar
Cancel |
Fig. 5-1 Project Wizard Starter
2. Choose Find drive units online... (see Fig. 5-1).
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The Wizard guides you through the procedure for creating a new project.

Project Wizard Starter |

1.
Create
new project

Introduction

2 3 4
PGAPC - Set Inzert drives Summary

interface

Flease enter the project data:

Project name: |F'roiek_4

Author: |Doku

Carnment;

Getting Started ;I

< Back | Cantinue > |

Cancel |

Fig. 5-2

Creating a new project

3. Enter the project name (e.g. "Project_1") and, if required, the author and a

comment (see Fig 5-2).

4. Click Continue > to set up the PC/PG interface.

Project Wizard Starter

1.
Create
new project

|ntroduction

4

2 L b
FPGAPC - Set Inzert drives Surmmary

interface

Specify the online connection to the drive unit:

Set
Ty CPES11[FROFIBLS)
1@
Change and test. ’}J
< Back Eonhnue > Cancel |

Fig. 5-3

Setting up the interface

5. In this example, you require a PROFIBUS interface on the PC/PG (e.g. PC
adapter (PROFIBUS). Choose Change and test and confirm your selection

with Continue >.
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The project Wizard searches for the drive unit ONLINE and inserts it in the project.
Once the drive unit has been found, the project Wizard displays it in the preview
screen (see Fig. 5-4) along with its PROFIBUS address (Drive_Unit_Adr10).

Note

The system searches for drive units or, more precisely, Control Units; in other
words, if more than one Control Unit exists in the system, more than one drive unit
is found.

The peripheral components of a drive unit (Control Unit, Active Line Module, and
so on) are not displayed until you load the drive unit configuration to the PG/PC.

Project Wizard Starter x|
1. 2 3 4
Intraduction Create PGEAPC - Set Inzert drives Surmrmary
new project interface

— Preview

E--% Project_1
ﬂg Drive_unit_addrd

Search far
reachable nodes

£ Back | Eontinue)l Cancel |

Fig. 5-4 Inserted drive unit

6. Click Continue >.
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The project Wizard displays a summary of the project (see Fig. 5-5).

Project Wizard Starter x|
1 2 3 4
Introduction Create FPG/PC - Set Ingert drives Summary
new project interface
The following zettings have been selected: ;I

- Project name: Project_1

- Interface: CPS511[PROFIBUS)

- Drive units:

Storage location: d:\SiemensStepS 7projsProjec_b

Drrivve_unit_addr8 [SIMNARMICS 5120 [B5L3uue-sbd mi-nns

<Ba-:k| CompleteDL

Fig. 5-5 Summary

7. Click Complete. The new project and drive unit are displayed in STARTER

(see Fig. 5-6).
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5.3
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Entering the component topology and configuring the
drive unit automatically

Once you have created the project and entered the drive unit with its PROFIBUS
address ONLINE, you have to enter the associated component topology and drive
unit configuration ONLINE.

[ STARTER - Project_1 oy = 3|
Froject Target system Yiew Options Window Help

B S e e T
|215 = 1w oo ] 1% | 5] salsalor{%]

2. Choose
Connect to target system.

1. Select the drive unit
Drive_Unit_Adr10.

Project
Press F1 ko open Help display. Offline mode [

Fig. 5-6 Project_1

1. Select the drive unit Drive_Unit_Adr10 in the project navigator.
2. Choose Connect to target system.

3. Select the drive unit Drive_Unit_Adr10 in the project navigator.
4

. Choose the Restore factory settings function key (see screenshot below).

Project Edit Targetsystem View Options ‘Window Help

EEE RS

Restore factory settings.

Fig. 5-7 Restore factory settings

5. Confirm the following queries and messages by choosing OK:

"Restore factory settings?” dialog box
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"The factory settings have been restored” dialog box

"The data has been successfully copied from RAM to ROM” dialog box

[PFSTARTER - Project_1 =
Project Targetsystem View Options ‘Window Help

| Dl ] | | ]| o] ]| e el | LB

[ | 89| alalote[ %

=————1]

=8P Project_1
B Insert single drive
&4l Drive_unit_addra
L&Y tomatic configuration
> Overview
> Configuration
> Topolagy
P Control_Unit

Project

®

Device | Operating made ]
Drive_unit_addie Ready

iA\ams [ Target spstem output % Disgnostios overview |

Press F1 ta open Help display. |Online mode [ [

Fig. 5-8 Automatic configuration

6.

In the project navigator, double—click Automatic configuration under the drive
unit.

Automatic Commissioning |
Status of the drive unit: Ilnitialization finished
Diive object type: IServo j
Upload type: Complete uplaad
Fiunning operation: “Waiting for 51 Click

Start automatic configuration.

Loadto P (Upoad) |/

Fig. 5-9 Automatic commissioning

7.

Click Start automatic configuration.

STARTER automatically searches for all drive unit components that are con-
nected properly and then uploads them. In this case, it has recognized a drive.
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Drive Object Type

¥ Sevo
A

i~ Selection of the supported drive object types

 Vector

Dr/ue

I Drive object type

Identification

Dirive 1

|sereo

-

Ickeritification via LED

Drive 2

rServo

Identification via LED

Choose Servo.

< Zuriick I Fertig stellen I

Abbrechen

Fig. 5-10  Automatic commissioning

8. In the "Drive object type” dialog box, choose Servo and then click Complete.
The system now loads the data from RAM to ROM and to the PG.

Automatic configuration {(ISD¥:413)

5

Please remember to also configure the motors on the following diives:

SERYD_03
SERVD_D4

Pleaze perform the following steps:

Go offline.
Run through the drive wizard on the appropriate drive and on the infeed if one is available.

Fig.5-11  Message

9. The system outputs another message listing all the drives for which you have to
configure the motors in OFFLINE mode. Click OK to confirm the message.

Note

The drives are equipped with standard motors.

If a drive is equipped with a motor with a DRIVE-CLIQ interface, the motor does

not need to be configured in OFFLINE mode.
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Automatic Commissioning 1'
Status of the drive unit: IInitiaIization finizhed
Drive object type: IServo j
Upload type: Complete upload
Fiunning operation: Automatic commissioning iz
completed

) Close
Close | 4

[ LoadioPoplsd) |

Fig. 5-12 Close automatic commissioning

10.0nce the automatic commissioning is complete, click Close.

In the project navigator, all the drive unit components that have been found are
displayed with, for example, the Control Unit, infeed, and drive (see Fig.
5-13).

=18 %]

[“* STARTER - Project_1
Froject Targetsystem View Options Window Help

Mlﬂ___ll—l lﬁ
| ElE | >

£ &P Project_t
) Insert single drive
o

Loy Topology
= Contrel_Unit
i i+ » Configuration
&= Inputsfoutputs
» Communication
)) Diagnastics
H supply_1
lnpuuuutput component
EI | Drives
% Insert drive

<y Drive_t

Configuration with, for example,
Control Unit, infeed, and drive.

Project
x
Level | Message BN
Information The following devices are not consistent online: Drive_unit_addi
Information Diive_unit_addié: plaad compleled
] | 3

98 o | [ Tonget system output [} Load to PG output [ %8 Diagrostos overvien

Fress F1 to open Help display.

Fig. 5-13  Automatic configuration

[Online mode

11.Choose Disconnect from target system.
The drive unit, components, and drives are installed in the STARTER project.

You now just have to configure the drive motors and check the topology.

To do so, proceed as described in Section 5.4.
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5.4
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Configuring the drive motors and checking the topology

Now that you have entered the component topology and configuration for the
drive unit and integrated these in the STARTER project automatically by carry-
ing out the steps described in Section 5.3, carry out the following steps to con-
figure the drive motor and check the topology.

[FF STARTER - Project_1 -1

Project Targetsystem View Options ‘Window Help

IEEEE] aslhIaJ\_l_ll_IJﬁlﬂlJﬁJ
IEE e mie ||| 1| | 5[] alaal %]

—Ex
=+ Project_1
B9 Insert single drive
E-flla Drive_unit_sddré
3 Overview
Configuration
Tapology
Control_Urit
> Configuration
8= Inputsoutputs

> Communication
D ot Double-click
o conpenent Drive navigator.

-7 Insert drive
B @ Drive_
-

fo p Contral logic
% Speed control
% Functions

» Commissioning
4% Communication
% Diagnostics

Project

Level | Message

Infarmation Drive_urit_addrG: 5 objscts not contained in the project exist on the contral
Information Drive_urit_addrB: Mot all data is up-to-date on the cortral

4 |

g Taiget system output g Load to PG output

Press F1 ko open Help display. —rr—
Fig. 5-14  Project_1 configuration

1. In the project navigator, choose the Drives folder and double—click Drive navi-
gator under the drive.

The Drive navigator dialog box provides an overview in which you can configure
the main drive functions.
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ﬂDrive_l - Drive navigator

=10l x|

= Setpointz fram higher-level contral
]
-7 2

Setnnint denntin

Click
Device configuration.

S

Device configuration Cammissianing

[iagnostics/ aptimization

Service
N king in: Change to:
B Al WOING 1N | —_— . gnnne.MDdusl 5t PGAPC interface. .
4| | H
m ¢-| Cloze | Help |
Fig. 5-15  Drive navigator

2. Click Device configuration to configure the drive motor

Device configuration

| click
Carry out drive configuration.

Wwhat do vou want to do?

58 |y

Carry out drive configuration

Check topalogy

|

Fig. 5-16  Device configuration

3. Click Carry out drive configuration. The project Wizard for configuring the
drive is displayed (see Fig. 5-17).
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Configuration - SINAMICS_CU320 - Control structure

Drive: Drive_1. DDS 0

w0 ption module -
M Inzert infeed
[MIrfeed configuratior
W] Infeed

[WIrfeed dive object
[WIFROFIEUS process
[WInzert dive

WD rive properties

Function modul

™ Extended setpaint channel

™ Technology controller

[~ Estended messages/monitoring

[(JFower_unit

Closed-oop contral
CIMatar Setpt
[Ctotor holding brake > /M contiol |
[CJEncoder j %

-
Control method.
ISpeed cantral [with encader] ﬂ

~&ctual speed value preparation

@

Work through the Wizard,
with Continue >!!!!

< Back I Cunllnw/tg Cancel | Help |

Fig. 5-17  Project Wizard

4. Work through the Wizard by choosing Continue > until you reach the point at
which you configure the motor (see Fig. 5-18).

Note

You only have to change the motor configuration; leave the infeed etc. as they are.

Configuration - SINAMICS_CU320 - Motor

[ Clption module | Drive: Drive_1,DD5 0. MD5 0
[ Inzert infeed I
[vlInfeed Configure the matar:
[W]Infeed - additional o
[WIFROFIEUS proces:
I niset drive " Motor with DRIVE-CLID interface
[w]Drive properties
ontrol structure

ame: IMotor

5. Select the motor type.

I | Bead out motor agait

% Select standard mator from list

[w] F'ower Linit
" Enter mator data
[t ator holding brake Motar bupe: 2,
— ype: 1FKE synchronous motor ful
[C1E neader I 4 J

[CDiive functions LI Mator selection:

[T T a T = LT RN

d=" | 0

1FKB0/0-wdK P
TFE42-0AF T 300,
1P/ B043-wdH Puwnn 450,
/rKE04 3K P BOO...
TFKE044-AF Fuw 300,
1FKE04d-dH Puwmnn 450,
e 300
6. Select the motor e 300

according to type s 300..

(Order No.).

R N N

Fig. 5-18  Motor configuration
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5. Select the motor type e.g.:
— 1FK6 synchronous motor or

— 1PH7 induction motor

6. Choose the appropriate motor from the Motor selection field according to type
(Order No.) (see type plate) and assign a name (Drive_1 Motor).

7. Click Continue > and work through the Wizard until the summary is displayed
(see Fig. 5-19).

Note
You only have to change the motor configuration; leave the infeed etc. as they are.

Configuration - SINAMICS _CU320 - Summary

[Vl nzert infeed a| The following data of the drive unit has been entered:
[w]Infeed
Opt Ll -
[@iinfeed - additionsl d Mo option made
[WIFROFIBLS proces: |nfeed:
[l Insert drive Mamne: [nfeed 1

Operating type: Line infeed/feedback

v i li
e pipeiss Operating mode: Active line module

[ Contral stiucture Oidler o E5L3130-7TEZ1-Gdx
[l Foveer unit Rated power: 16 ki
[w] 4 atar Fiated curent: 27 4
MM ator holding brake Line filter: Awvailable
]E ncoder Yolkage sensing module: Mot available
Infeed - additional data:
[WIFROFIELS proces: Supply system / DC link identification when first switched on: Yes

Device connection voltage: 400 W
— Rated supply frequency: 50 Hz
FROFIBUS process data exchange [infeed):
PROFIBUS FZ0 message frame: Free telegram configuration with
EICO (939
Cirive properties:
Marne: Drive_1
Operating type;
Operating mode: Servo amplifier
Control structure:
Control tppe: S peed contral [with zenzor)

Power unit LI

Copy text to clipboard |

e _ e |

Fig. 5-19  Summary

8. Click Finish.
Before saving the project, check the topology in STARTER.

Device configuration : 7] x|

Click
Check topology.

‘wihat do you want to do?

<2 |p il

Carry out drive configuration Check topalogy

o |

Fig. 5-20  Device configuration
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9. Click Check topology.

“FSTARTER - Project_1 - [Drive_unit_addr8 - Topology]

L
[ Project Targetsystem View Options Window Help

=lElx]
=181 x|

| i@l @] £l o[- el )| ]| s

Choose
Project > Save.

|Jﬁi+-z\

Topoloay

| Froectset | Set Aetiial “ergleich ~

B —
) Overiew Bl control_Unit (L)
[ Corfiuraion - [T sweelt @
[ Contral_Unit Free
> Configuration o[ Fres
. 8 Inputsfoutputs =} [T Drive_t Power_unit (3)
| P Communication ! T Free
| P Diagnostics
Supply_1 Drive_1.5MC20_to_Motor (S)
Inputjoutput componient Free
B4 Drives Free
21 trsert dive el TPPALE_OLEQUE_COMpORENE_L
B Drive_t
>
- Configuration
-~ » Control logic B  Component depot
B3 Speed contral Free
- Functions
- Commissioning
-3 Communication
-3 Diagnostics

Eilter: |DRIVE CLIQ + Dption Slat 7

Updaie topoloay Close Help
Project {1 Diive_1 @y Drive_urit_addd |
M [Level | Message
4] 0]
5 Target system output E Load to PG output E Topolagy output
Press F1 to open Help display. Offline mode | IR N

Fig. 5-21  Topology tree

10.In this window, check the topology and DRIVE-CLIQ connection and compare

this with the actual topology (see Fig. 5-21).

11.Choose Project > Save and save the project under the name "Project_1".

To start the motor, continue by carrying out the steps described in Chapter 4.
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Explanation of this glossary (abridged)

German term English term? Abbrev.})

Definition of the term in English 1) —> if available

Explanation of this glossary

Active Line Module Active Line Module none

Antrieb

Controlled, self-commutating feed/feedback unit (with —> "IGBT"s in feed/feedback
device), which supplies the DC link voltage for the —> "Motor module”s.

Drive none

The drive includes the motor (electric or hydraulic), the actuator (converter, valve),
the control unit, measuring system, and supply components (line infeed module,
pressure reservoir).

For electric drives, a distinction is made between a converter system and an in-
verter system. With a converter (e. g. —> "MICROMASTER 4”), the line infeed, the
actuator, and the control component form a single device from the point of view of
the user. With an inverter system (e. g. —> "SINAMICS S”), the supply is ensured
by means of a —> "Line module”, thereby realizing a DC link to which the —> "In-
verters” (—> "Motor module”s) are connected. The —> "Control unit” is implemented
as a separate device and connected to the other components by means of

—> "DRIVE-CLIQ".

Antriebsgerat Drive Unit none

The drive unit includes all the components connected via —> "DRIVE-CLIQ" that
are required for carrying out drive tasks: —> "Motor module” —> "Control unit”
—>"Line module”, and the required —> "Firmware” and —> "Motor”s, but not addi-
tional components (such as filters or reactors).

Several —> "Drive”s can be implemented in a drive unit.

See —> "Drive system”.
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Antriebskomponente Drive Component none

Hardware component connected to a —> Control Unit via —> DRIVE-CLIQ, for
example.

Examples of drive components: —> "Motor module”s, —> "Line module”s,

—> "Motor"s, —> "Sensor module”s, and —> "Terminal module”s.

The overall arrangement of a control unit including the connected drive compo-
nents is called a —> "Drive unit”.

Antriebsobjekt Drive Object DO

A drive object is an autonomous, individual software function with its own

—> "Parameter”s. It may also have its own —> "Fault’s and —> "Alarm”s. The drive
objects may exist by default (e. g. On—board I/O) and may be easy to create (e. g.
—> "Terminal board” 30, TB30). It may also be possible to create more than one
(e. g. —> "Servo control”). As a rule, each drive object has its own —> "STARTER”
window for parameterization and diagnostic purposes.

Antriebs—Parameter Drive Parameter none

Parameters of a drive axis that include, for example, the parameters of the corre-
sponding controllers, as well as the motor and encoder data. The parameters of
the higher—level technology functions (positioning, ramp—function generator), how-
ever, are called —> "Application Parameters”.

See —> "Basic Unit System”.

Antriebssystem Drive system none

The drive system includes all the components in a product family (e. g. SINAM-
ICS). A drive system comprises, for example, —> "Line module”s, —> "Motor mod-
ule”s, —> "Encoder”s, —> "Motor”s, —> "Terminal module”s, and —> "Sensor mod-
ule”s, as well as additional components (reactors, filters, cables, etc.).

See —> "Drive Unit”

Antriebsverband Drive line—up none

A drive line—up comprises a —> Control Unit and the and the —> Motor Modules and
—> Line Modules connected via —> "DRIVE-CLIQ".

Basic Infeed Basic Infeed none

Overall functionality of an infeed with —> "Basic Line Module”, including the
required additional components (filters, switching devices, and so on).

Basic Line Module Basic Line Module none

Unregulated line infeed unit (diode bridge or thyristor bridge, without feedback) for
rectifying the line voltage of the —> "DC Link”".
Use this term in all languages.
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CompactFlash Card CompactFlash Card none

Memory card for non—volatile storage of the drive software and corresponding
—> "Parameters”. The memory card can be plugged into the —> "Control unit” from
outside.

Control Unit Control Unit CUxxx

Central control module: the feedforward and feedback control functions for several
—> "SINAMICS” —> "Line Module”"s, and/or —> "Motor Module”s are implemented in
this module.

There are three types of control unit:

— SINAMICS control units (e. g. —> "CU320")

— SIMOTION control units (e. g. —> "D425” and —> "D435")

— SINUMERIK control units (e. g. NCU710, NCU720, and NCU730)

Cu320 Cu320 none
SINAMICS —> "Control unit” with 4 —> "DRIVE-CLIQ socket’s and 16 digital inputs/
outputs.

Double Motor Module Double—-Motor Module none

Two motors can be connected to and operated with a Double Motor Module.
See —> "Motor module” —> "Single motor module”
Former term: —> "Double—axis module”

DRIVE-CLIQ DRIVE-CLIQ none

Abbreviation for "drive component link with 1Q”.

Communication system for connecting the different components of a SINAMICS
drive system (e. g. —> "Control unit”, —> "Line module”s, —> "Motor module”s,

—> "Motor"s, and speed/position encoders.

The DRIVE-CLIQ hardware is based on the Industrial Ethernet standard and uses
twisted—pair lines. The DRIVE—-CLIQ line provides the transmit and receive signals,
as well as the +24 V power supply.

Einspeisung Feeding Section none

Input component of a converter system for generating a DC link voltage to supply
one or more —> "Motor module”s, including all the required components (e.g.
—>"Line module’s, fuses, reactors, line filters, and firmware, as well as propor-
tional computing power (if required) in a —> "Control unit”.
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externer Geber External encoder none

Position encoder that is not built in or mounted on the —> Motor, but via a mechani-
cal transmission element or mechanical intermediate element.

The external encoder (see —> "Externally—Mounted Encoder”) is used for

—> "Direct Position Detection”.

Geber Encoder none

An encoder is a measuring system that captures actual values for the speed
and/or angular/position values and makes them available for electronic processing.
Depending on the mechanical construction, encoders can be integrated in the

—> "Motor” (—> "Motor encoder”) or mounted on the external mechanics (—> "Exter-
nal encoder”). Depending on the type of movement, a distinction is made between
rotary encoders (also known as "rotary transducers”) and translatory encoders

(e. g. —> "Linear encoders”). In terms of measured value provision, a distinction is
made between —> "Absolute encoder’s (code sensors) and —> "Incremental

encoder’s.
See —> "Incremental encoder TTL/HTL” —> "Incremental encoder sin/cos 1 Vpp”
—> "Resolver”

Line Module Line Module none

A line module is a power component that generates the DC link voltage for one or
more —> "Motor module”s from a 3—phase mains voltage.

The following three line module types are used for SINAMICS:

—> "Basic Line Module”, —> "Smart Line Module”, and —> "Active Line Module”.
The overall function of an infeed, including the required additional components
(—> "Line reactor”, proportional computing power in a —> "Control unit”, switching
devices, and so on), is called —> "Basic infeed”, —> "Smart infeed”, and —> "Active
infeed”.

Motor Motor none

For the electric motors that can be driven by —> "SINAMICS”, a basic distinction is
made between rotary and linear motors with regard to their direction of motion, and
between synchronous and induction motors with regard to their electromagnetic oper-
ating principle. For SINAMICS, the motors are connected to a —> "Motor Module”.
See —> "Synchronous Motor”, —> "Induction Motor”, —> "Built—In Motor”, —> "Motor
Encoder”, —> "External Encoder”, and —> "Third—Party Motor”.

Motor Module Motor Module none

A motor module is a power unit (DC—AC inverter) that provides the power supply
for the connected motor(s).

Power is supplied through the —> "DC link” of the —> "Drive unit”.

A motor module must be connected to a > "Control unit” via a —> "DRIVE-CLIQ".
The open—loop and closed—loop control functions of the motor module are stored in
the control unit.

—> "Single Motor Module”s and —> "Double Motor Module”s are available.
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Motorgeber Motor Encoder none

An —> "Encoder” (e. g. —> "Resolver”, —> "Incremental encoder TTL/HTL”, or

—> "Incremental encoder sin/cos 1 Vpp”, which is integrated in or attached to the
motor.

The encoder detects the motor speed and, in the case of synchronous motors,
also the rotor position angle (of the commutation angle for the motor currents).
For drives without an additional —> "Direct position measuring system”, it is also
used as a —> "Position encoder” for position control.

In addition to the motor encoders, —> "External Encoder”s for —> "Direct Position
Sensing” are available.

Option Board Option Board
PC board inserted in the —> "Control unit” (e. g. a —> "Terminal board” 30, TB30).

Option Slot Option Slot none

Slot for an optional module (e.g. in the —> "Control Unit”).

Parameter Parameter none

Variable quantity within the drive system that the user can read and, in some
cases, write. For —=>SINAMICS, all specifications defined in the —> PROFIdrive
profile are defined by a parameter.

See —> "Visualization parameter” —> "Adjustable parameter”

PROFIBUS PROFIBUS none

Field bus to IEC 61158, Sections 2 to 6.
The abbreviation "DP” is no longer included because PROFIBUS FMS is not stan-
dardized and PROFIBUS PA (for Process Automation) is now part of the "general”

—> "PROFIBUS".
Sensor Module Sensor Module SMCxx
SMEXxX
SMIxx

Hardware module for evaluating speed/position encoder signals and providing de-
tected actual values as numerical values at a —> "DRIVE-CLIQ socket”.

Three mechanical sensor module variants are available:

— SMCxx = Cabinet-mounted sensor module = sensor module for snap—on mount-
ing in the control cabinet.

— SME = Sensor module externally mounted = sensor module with high degree of
protection for installation outside the cabinet unit

— SMI = Sensor module internal = sensor module integrated in the motor flange
outlet
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Servoantrieb Servo Drive none

An electric servo drive comprises a motor, a —> "Motor module”, a —> "Servo con-
trol” and, in most cases, a speed and position —> "Encoder”.

Electric servo drives are normally extremely precise with a high dynamic response.
They are designed for cycle times to less than 100 ms, and often have a short—
time overload capacity, which enables quick acceleration. Servo drives are avail-
able as rotary and linear drives. and are used for machine tools, handling robots,
and packaging machines.

Servoregelung Servo Control none

For —> "Motor”s equipped with a —> "Motor encoder”, this control type allows oper-
ation with a high level of —> "Accuracy” and —> "Dynamic response”.
In addition to the speed control, a position control can be implemented.

SITOP power SITOP Power none

—> "Electronics power supply” component.
Example: 24 vV DC

Smart Line Module Smart Line Module none

Unregulated line infeed/feedback with a diode bridge for the infeed and stall-pro-
tected, line—commutated feedback via —> "IGBT"s.
The smart line module provides the DC link voltage for the —> "Motor Module”s.

STARTER STARTER none

STARTER is used to commission and parameterize drive units. This tool can also
be used to execute the diagnostic functions required during servicing (e.g.
PROFIBUS diagnostics, function generator, trace).

See —> "SIZER", —> "Engineering System”.

Steuerwort Control Word STW

Bit—coded —> "Process data” word. —> "PROFIdrive” transmits this word at cyclic
intervals to control the drive states.

Terminal Board Terminal Board TBxx

Terminal extension module for plugging into a —> "Control Unit”".
In —> "SINAMICS", for example, terminal board 30 (TB30) is available with analog
and digital 1/0 terminals.
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Terminal Module Terminal Module TMxX

Terminal extension module for snapping onto the installation rail, for installation in
the control cabinet.

In —> "SINAMICS”, for example, the following terminal modules are available:

— TM3x = terminal modules with digital and analog I/O terminals

— TM4x = terminal modules with encoder emulation

Vektorregelung Vector Control

Vector control (field—oriented control) is a high—performance control type for
induction machines. It is based on an exact model calculation of the motor and two
current components that simulate and accurately control the flux and torque by
means of software algorithms, thereby enabling predefined speeds and torques to
be observed and limited accurately and with a good dynamic response.

Two vector control types exist:

The frequency control (—> "Sensorless vector control”) and the speed-torque con-
trol with speed feedback (—> "Encoder”).

Zustandswort Status Word ZSW

Bit—coded —>"Process data” word. —>"PROFIdrive” transmits this word at cyclic
intervals to control the drive states.
The abbreviation "ZSW” must be used in all languages!
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